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Community Place Conductor ("Conductor" in the following pages) is the authoring 
that conforms to VRML 2.0. Conductor 2.0 has the following features: 

Conforms to VRML 2.0. 
Drag and drop to add a node. 
Enables you to specify values for node attributes. 
Enables you to specify textures for sound and objects. 
Enables you to switch between the Execution and Edit modes. 
Conforms to Java (JRE1.1.3, JDK1.1.3, or later). 
Enables you to edit independently in each scope by switching the current scope
The Script Expert function to automatically create a script node. 
Enables you to add/delete routes while displaying it on the screen. 
Enables you to edit keyframes. 
Enables you to edit PROTO. 
Supports USE. 

This manual describes each function of Conductor. For the information of how to cre
world with Conductor, see Tutorial . 
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■■■■ Installing Conductor
Before starting Conductor, check to see if your system meets the following req
ments. 

* Necessary when displaying Help or Anchor. 
** Necessary when creating contents in Java. 

Note: Conductor may not operate properly with some hardware. For details, see
"Restrictions." 

table 1:  Required Environment

Recommended Environment

Hardware
PC/AT-compatible machines operated under Windows 95/Window
NT 4.0 or later

CPU Pentium 90MHz or higher

Memory 32MB or more

Free disk 
space

20MB or more (40MB required at the time of installation)

Display reso-
lution

800x600 pixels or higher

Display colors 65536 colors or more

Software
Netscape Navigator for Windows (Ver. 3.0 or later)  or
Microsoft Internet Explorer (Ver. 3.0 or later) *

JAVA** JDK1.1.3 or later

Sound Sound board + a speaker or headphones
2
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■■■■ Uninstalling Conductor
You can easily and safely uninstall Conductor in the following procedure: 

1. Click the Start button. 
2. Open Program, and select Community Place Conductor. 
3. Select Uninstall from the menu. 

Note: A part of the temporary files or the files you created after installing Conductor
may not be deleted by uninstalling Conductor. In such a case, delete all the
Conductor directories left. Before re-installing Conductor, make sure that all
the Conductor directories are completely deleted.

■■■■ Starting or Quitting Conductor

••••     Starting Conductor 
Choose from the Start menu in the order of Program, Community Place Con
tor, and Community Place Conductor. To newly create a world, choose the 
New menu. To load an existing VRML 2.0 file, choose from the File/Open me

Note: The Conductor is not compatible with the VRML 1.0 files. Convert all the files
you use to the VRML 2.0 format with vrml1to2 (http://vs.sony.co.jp/Download/
vrml1to2.htm).

••••     Quitting Conductor 
Choose File/Exit from the menu. If you are working on the file, you will 
prompted to save the changes. 
3
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■■■■ Using Conductor

Main window (Manages the overall procedure for using Conductor.)
3D Perspective View window (Displays objects in the perspective projection mode
Appearance window (Specifies the color and texture of an object.)
Attribute window (Specifies the attribute of a node.) 
Keyframe Editor window (Edits Interpolator.) 
Library window (Manages the library.) 
Message window (Displays various messages.)
Multi User Window (Specifies the multi user world.)
Parallel View window (Displays objects in the parallel projection mode.) 
Route window (Specifies route for events.) 
Scene Graph window (Displays the tree structure of a world.) 
Script Expert window (Creates a Script model.) 
Text Editor window (Used to edit a Java file.) 
Texture Mapping window (Edits Texture Mapping.) 

Each window can be displayed or closed when necessary.

Figure 1: Using Conductor
4
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■■■■ Reference

VRML97 Specifications 
http://vag.vrml.org/VRML97 

Virtual Society on the Web site 
http://vs.sony.co.jp
5
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Main Window

This window allows you to newly create, read, store, and run a world, change the m
mode, switch to the keyframe edit mode, and add/delete objects. 

Figure 2:  Main window

■■■■ File menu 

••••     New 
Click New on the File menu. This opens a new file and displays windows, suc
a 3D Perspective Window (to be described "3D View window" in the followi
pages) to operate a world. 

••••     Open, Reopen 
To load a world from a file, press the Open button  the File menu. The 

Open dialog box appears on the screen. Specify the name of the file you w
open. To load the file previously loaded, click Reopen on the File menu. The
of all the files appears on the screen.  You can select the file you want to loa
of the list. 

The following are other methods to opening a file.  Shortcuts files are not supported in any of
the cases below. 
- Drop a VRML file on the Conductor icon.
- Execute Conductor and drop a VRML file on the Main Window.
- Load from command line ( ex: cpcondct foo.wrl )

Note: The Conductor is not compatible with the VRML 1.0 files. Convert all the files
you use to the VRML 2.0 format with vrml1to2 (http://vs.sony.co.jp/Download/
vrml1to2.htm).
6
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••••     Save 
Saves the world to a file.  It is also done by pressing the Save button   .

••••     Save As
To save the file under a new name, click Save As on the File menu.  The File
Dialog Box appears on the screen.  Type  the name under which the file is 
saved.

••••     Close
To close a world, click Close on the File menu.

••••     Exit 
To quit Conductor, click Exit on the File menu. If you are working on the file, y
will be prompted to save the changes when you click Close or Exit. To sav
changes, click Yes. 

Note: Do not save files in a temporary directory ("C:\Program Files\Sony\Commu-
nity Place Conductor\tmp" by default). All the files contained within the tempo-
rary directory will be deleted at the time of starting or quitting Conductor. 

■■■■ Edit menu 

••••     Undo
If you wish to undo your work, click Undo on the Edit menu (or simultaneou
press Ctrl and z keys). 

Note:  You can undo your work as many times as you want, but there are some
functions that you cannot undo.

••••     Redo
If you wish to bring back the work that you have cancelled by using Undo, c
Redo on the Edit menu (or simultaneously press Shift and Ctrl and z).  Re
only available right after using Undo. 

••••     Cut 
To delete a node, select the node you want to delete, then click Cut on the
menu (or simultaneously press Ctrl and x keys). You can select the node to d
from within the 2D/3D View Window or the Scene Graph Window. You can a
paste the node you have cut. 
7
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••••     Copy 
To copy a node, select the node you want to copy, then click Copy on the
menu (or simultaneously press Ctrl and x keys). You can also paste the nod
have copied. 

••••     Paste 
If a node has been loaded onto the Cut or Copy buffer, you can paste it. On
currently selected node can be pasted. If it cannot be pasted (because of inc
tent node type), a warning message will appear.

Note: The Inline node cannot be copied. 

••••     Delete
Deletes a node.

••••     Keyframe
Opens the Keyframe Editor window to edit the Interpolator node.  Please ref
the "Keyframe Editor" section of the manual for more information.

■■■■ View menu 
This menu allows you to display the Conductor windows. The menu items o
window currently displayed are checkmarked. 

■■■■ Run menu

••••     Run 
To check to see how the world works on the screen, click Run on the View m

or press the Play button 

Note: While running, only the Main window, 2D/3D View window, Message window,
and Java Console window can be used.

••••     Pause 
To temporarily stop the world, click Pause on the View menu or press the P
button  . To resume playing back the world, press the Pause or Play b

again.
8
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••••     Stop 
To stop playing the world and return to edit mode, press the Stop button 

■■■■ Script menu 

••••     Expert 
Activates the Script Expert Window that lets you create a Script model.  For m
information, please refer to the "Script Expert Window" section of this manua

••••     Build 
Compiles only the modified script files. 

••••     Rebuild 
Recompiles all the script files. 

Note: Script menu can only be used when JDK 1.1.x is installed.  It is not compati-
ble with JDK 1.2.x.

■■■■ Options menu

••••     Environment
The following Environmental settings dialog boxes (Figure 3 ) will appear. 
9
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Figure 3: General page

Blink bounding box when selected: 
Check this to blink the bounding box around the selected object.

Show all nodes in Keyframe Editor source:
Check this to display all the specifiable nodes within the Source selec
combo box within the Keyframe Editor Window. 
10
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Figure 4: Grid page

Show grid in view window:
Check this to show grid lines in the 2D/3D View Window.  When check
interval and area of the grid can be configured using the slider bar or e
ing values in the edit box.
11
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Figure 5: Editor page

In this page, number of tab stops, font, size, colors for each Category of text
mal text, keyword, comment,background colors)  can be configured.  

■■■■ Help menu 

••••     VRML97 Spec 
Displays the specifications of VRML97 within the HTML browser. 

Note:1) Netscape Navigator 3.0 or later or Microsoft Internet Explorer 3.0 or later is
required to display the specifications.

Note:2) For the copyrights of VRML97 online manual, please read the attached
"vrml97copyright.html".

Note:3) If Help menu is selected while Netscape Navigator or Microsoft Internet
Explorer isn’t running, it will open the browser without showing the Help file.
To view Help, select the Help menu once again. 

••••     Show CLASSPATH 
Displays the class path information when the Sun JRE 1.1.x or JDK 1.1.x
been installed. 
12
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Note: The class path information will not be displayed when JRE or JDK is not
detected. 

Note: You will need JDK to compile a script.  Please install version 1.1.x for JRE
and JDK. JDK 1.2.x cannot be used. 

••••     About 
Displays the About dialog box shown below. This dialog shows the version n
ber of Conductor, the information about the Java that has been recognize
Conductor. 

Figure 6: About dialog
13
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■■■■ Changing the mouse mode 
Conductor provides you with the following mouse modes to select from. Switch
clicking one of the corresponding buttons: 
 

Only a selected object can be moved, rotated, or scaled. You can select an 
from within the 3D View Window or the Scene Graph Window. Selecting an obj
the box enclosing it will start blinking (when the blinking option is selected).

■■■■ The Tool Bar
To add a node such as geometry or sensor to a world, choose the node that yo
to add on the Tool Bar (figure 4), and then click on the 3D View window. (Ple
refer to the tutorial for usage)

Figure 7: Tool bar

table 2: Mouse Modes

 Walk Used to move your eye position/direction within the 2D/3D
View window.

 Move Used to move an object.

 Rotate Used to rotate an object.

 Scale Used to change the scale of an object.
14
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table 3: Geometry

Button Node

  Box Cube

 Cone Cone

 Cylinder Cylinder

 Sphere Sphere

 Text Text

 IndexedFaceSet Polygon (a quadralateral by default)

 ElevationGrid Land surface (a plane by default)

 Extrusion A 3D figure extruded from a 2D figure

table 4: Sensor

Button Node

 ProximitySensor Sensor to detect a viewpoint in a region

 TimeSensor Sensor of time

 TouchSensor Sensor to detect a hit on the object (for example, 
mouse click)

 PlaneSensor
Sensor to detect the dragged distance as amount 
movement on the xy-plane on the local coordinate
system

 SphereSensor Sensor to detect the dragged distance as amount 
rotation.

 VisibilitySensor Sensor to detect whether the region is included in
the visible range
15
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table 5: Common

Button Node

 DirectionalLight Parallel light source

 PointLight Point light source

 SpotLight Spotlight

 WorldInfo Defines world information

table 6: Bindables

Button Node

 Fog Sets a fog

 Viewpoint Adds a viewpoint

 Background Sets a background

 NavigationInfo Sets a navigation information

table 7: Group

Button Node

 Anchor Links to an URL

 Billboard
Automatically rotates an object to keep a specific
direction against the viewpoint.

 Collision Detects collision of the viewpoint and an object

 Group Group

 Transform Defines the local coordinate system

 Inline Reads data from another file
16
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The 3D View window displays all the nodes as the surface models in the 3D persp
projection view.

Figure 8: 3D View Window

■■■■ Reading a VRML file
You can add an object to a scene by dropping a VRML file into the 3D View w
dow.

Note: There are some restrictions on dropping a file to the 3D View window.  Please
refer to the restriction page (doc\restrict\restrict-e.txt) for more information.
17
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■■■■ Selecting an object
If you select an object, the box enclosing the object starts blinking to indicate th
is currently selected. The local coordinate for the selected object will also start b
ing. (Red represents the local Y-axis, blue the Z-axis, and green the X-axis.
arrow marks indicate the positive directions of the axes.)

■■■■ Displaying your eye position/direction 
The values of your eye position/direction currently set are indicated on the sub-
at the lower-left corner. You can change the display as follows by clicking on
panel:
 

■■■■ Creating an object 
You can create an object by using the buttons on the Main Window or dragging
dropping icons from the Library Window.  The object will be created at the ce
position of the 3D View Window, just in front of the eye position regardless of wh
the mouse button was released. 

••••     To create a node from the Main Window>

1. Select the library you want to create an object out of from the Primitive ba
the Main Window.

2. Press the left mouse button on the object you want to create; the mouse 
will be highlighted and kept caved-in. 

3. Drag the mouse pointer onto the 3D View Window. 

table 8: Parameters shown on the eye position panel

Parameters Variables Example

Eye position in world coordi-
nates

(P x, y, z)

Distance from the eye position
to the center position of the
selected node

(D d )

Eye direction in world coordi-
nates

(V x, y, z)
18
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4. Left-click here again to display the selected object.

Note:1) Objects cannot be added to some nodes.  When creating an object, please
check which node is selected in the Scene Graph Window.

Note:2) Nodes that are created with Transform, such as Geometries and Light
Sources, will be shown on the 3D View Window, but invisible nodes such as
Sensors and Scripts will not be shown.  Created nodes can be viewd on the
Scene Graph Window.

■■■■ Walk through a world 
Before walk through the 3D View, select the Walk  in the Conductor window

You can move in every direction basically by dragging with the left mouse bu
pressed or by using the arrow keys on the keyboard.

table 9: Walk

Movement
Modifier 

keys
Mouse

 Arrow 
key

 Eye 
position

Eye 
direction

Move for-
ward

Drag upward up moves
does not 

move

Move back-
ward

Drag down-
ward

down moves
does not 

move

Turn right
Drag right-

ward
right

does not 
move

moves

Turn left Drag leftward left
does not 

move
moves

Look up Shift key Drag upward up
does not 

move
moves

Look down Shift key
Drag down-

ward
down

does not 
move

moves

Move 
upward

Shift + 
Ctrl keys

Drag upward up moves(*)
does not 

move

Move down-
ward

Shift + 
Ctrl keys

Drag down-
ward

down moves(*)
does not 

move
19
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Note 1: <moves (*)> indicates that the eye position will move only in the direction of
Y-axis.

Note 2: <moves (#)> indicates that the eye position will not move in the direction of
Y-axis, but will move in the directions of X and Z-axes only on the surface
vertical to the eye direction. 

■■■■ Moving an object 
Before moving an object in the 3D View mode, select the  Move mouse mod

the Main window. 
You can move only the currently selected object by dragging it with the left mo
button. At the position where you want to place the object, release the left m
button. The object can be moved only on the surface that goes through the or
center position of an object and is vertical to the eye direction.

Note: You may not be able to select an object when it is located too far away.  

■■■■ Rotating an object 
Before rotating an object in the 3D View mode, select the  Rotate mouse m

in the Main Window.
You can rotate only the currently selected object by dragging the mouse arou
with the left button pressed. The object can be rotated only on the axis that
through the center position of the object. To stop rotating the object, release th
mouse button.

Move right-
ward

Shift + 
Ctrl keys

Drag right-
ward

right moves(#)
does not 

move

Move left-
ward

Shift + 
Ctrl keys

Drag leftward left moves(#)
does not 

move

table 9: Walk

Movement
Modifier 

keys
Mouse

 Arrow 
key

 Eye 
position

Eye 
direction
20
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■■■■ Scaling an object 
Before scaling an object in the 3D View mode, select the  Scale mouse mo

the Main Window.
You can scale only the currently selected object by dragging it with the left mo
button pressed. If you have satisfactorily enlarged or reduced the object, relea
left mouse button. An object will be scaled with its center position on the cen
axis.

Note: With the mouse, you can only scale the object proportionally in every direc-
tions.

■■■■ Pop-up menu 
The pop-up menu can be displayed by right-clicking on the 3D View. 

Figure 9: Pop-up menu in the 3D View
21
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The Pop-up menu provides the following sub-menus:

••••     Home Position 
Used to locate your position when you get lost or when you want to return to
start position.

Note: The Home Position corresponds to that specified in the Viewpoint node within
the VRML file or that specified by default (0, 0, 0).

••••     Examine 
Used to monitor ws around the object currently selected. This menu is effe
only in the 3D View mode. You can use the menu in the following procedure:

1. Specify the Walk  mouse mode in the Conductor window.

2. Select the object you want to monitor.
3. Select Examine ON from the pop-up menu. 

Note 1: Examine On can be selected only when a node that can be monitored is
selected. 

With Examine ON, the eye direction changes so that the object you want to m
tor appears at the center position of the window. 

Note 2: The distance from the object never changes since the eye position does not
change. 

4. Dragging the mouse with its left button pressed around the object will cha
your eye position/direction. This enables you to monitor the object fr
every angle.

Note 3: With Examine ON, 3D View normally does not allow you to walk through a
world. The Parallel View allows you only to walk. 

Note 4: In the Examine mode, you cannot  select other objects. To select other
objects, exit the Examine mode. 

To quit monitoring the object, select Examine OFF from the pop-up menu. W
Examine OFF, the background color of the eye position indicator panel retur
gray, and your eye position/direction last selected will be restored.

••••     Reset Tilt 
Restores your original view direction (to the parallel).
22
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••••     Mouse Mode 
Enables you to select the mouse mode (Walk, Move, Rotate, and Scale).

••••     Viewpoint 
Displays all the Viewpoint nodes existing within the world. You can swiftly mo
to your desired location by selecting one of the displayed Viewpoints.

Note: The Viewpoint menu shows the strings specified in description. Viewpoint is
not set in the newly created world.

••••     Adjust Viewpoint 
This menu is available only when Viewpoint is selected. The currently sele
eye position/direction can be reflected in Viewpoint.
23
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Appearance Window

Used to specify the color and texture of the object currently selected. This win
enables you to edit the Material node, ImageTexture node, TextureTransform node, 
are included in the Appearance node. For the details of how to use each node, see
VRML97 Specifications."

■■■■ Editing the Material node 
Click the material tab to display the Material sheet on which you can specify
attributes included in the Material node.

Note: Press the Enter key after typing the name of a node within the DEF name edit
box.

Figure 10: Selecting the material tab

••••     Specifying colors with the ColorMap dialog
You can specify a color by using the ColorMap dialog. You can activate the 
orMap dialog by clicking the rectangles on the right of each color (diffuse, e
sive, and specular). Dragging the mouse on the color panel on the left will ch
the Hue (H) and Shade (S). Dragging the slide bar will change the Brightness
24
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Figure 11: ColorMap dialog

■■■■ Editing the Texture node 
Click the texture tab to display the Texture page on which you can edit the Im
Texture attributes and the DEF name. 

Figure 12: Selecting the texture tab

Note:1) The MovieTexture and PixelTexture nodes are not supported. 
Note:2) ress the Enter key after typing the name of a node within the DEF name edit

box.

Local indicates the actual location of the texture file. The address in Local is us
the same as that in URL (relative URL must be converted to the absolute U
Immediately after the file is dropped out of the Library Window, Local indicates
Library directory.
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Save or Save As copies the file to the location specified in URL, and thus both 
and Local refer to the same file. (Local can be changed only by using Choose F

■■■■ Editing the TextureTransform node 
Click the textureTransform tab to display the textureTransform page on which
can edit the textureTransform attributes and the DEF name. 
On mapping a texture, set the parameters here to adjust the translation, rotatio
the scale.

Note: Press the Enter key after typing the name of a node within the DEF name edit
box.

Figure 13: Selecting textureTransform
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You can specify the attribute and DEF name of the node currently selected in this win
The status bar at the bottom of the window shows the information about the field th
mouse pointer is on. 

Figure 14: Attribute Window

The icon beside the attribute name indicates the kind of field for the item.

Note: eventIn, eventOut is shown only on Script nodes and Proto instances.

table 10: FIelds and Icons

Kind of fields Icon

field

exposedField

eventIn

eventOut
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■■■■ Editing a DEF name 
When routing events or creating a node with USE, use this function. Type the 
of a node within the DEF name edit box, then press the Enter key.

■■■■ Editing attributes 
There are 4 types of attributes, all conforming to the Node field types of VRML 
Value, Character string, Color, and BOOL.

To edit the BOOL type attributes, change the values by double-clicking the area
cated with "TRUE" or "FALSE."

If "(SFColor)" is displayed in the edit area, its attribute is the Color type. Dou
click the edit area, and the ColorMap dialog box will appear. Select your des
color and press the OK button.

To apply the newly specified values to the world you are in, press the Enter k
the Up/Down arrow key.

Note: If "+" is displayed at the right side of an item, you can display an edit field by
double-clicking it. To erase the edit box, click it again. 

■■■■ Wizard tab
Conductor 2.0 provides you with the Object Customize Wizard which enables yo
edit attributes of objects more easily than you do using the former Attribute Wind
If the selected object conforms to Wizard, the Wizard tab appears in the Attr
Window. User friendly GUI(Graphical User Interface) will help you edit th
attributes. The PROTO library includes various library objects. Dragging and d
ping those objects onto the 3D View, the Wizard tab appears. You can custo
those objects by adjusting the slide bar.

Note: The changes made in the Attribute Window will not be applied to Object Cus-
tomize Wizard.

Note: You cannot use "Undo" on attribute changes made by Object Customize Wiz-
ard.
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■■■■ Editing nodes within PROTO 
If a node within PROTO is selected, all the fields including eventIn and even
appear in the Attribute Window. The fields can be mapped by using IS (or ca
unmapped).

Note: For more information on seleting node inside PROTO, please refer to "Scene
Graph Window" section of this manual.
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■■■■ Pop-up menu 

••••     map with IS/new 
Newly maps a field using IS. When a field is mapped, the following dialog 
appears on the screen in which you can change field names.

When mapping a new field/exposedField, the value before the field is ma
will be used as the default value.
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Note: For the details of editing within PROTO, see "Restrictions."

••••     unmap from IS 
Releases a mapped field.

■■■■ Editing the Script node 
You can add or delete fields when the Script mode is selected. If a class file e
however, the source file (.java file) also needs to exist. If URL is not specified,
can add or delete fields.
31



Keyframe Editor Window

me
osed-

, or

y-

tton
Keyframe Editor Window

This window is used to edit the Interpolator node defied in VRML 2.0. In the Keyfra
Editor mode, the Interpolator node that automatically reflects the changes on exp
Field is created. The route also is automatically added in this mode.
To return to the normal edit mode, exit the Keyframe Editor mode.

Note: In Keyframe Editor mode, editing an object means editing the Interpolator,
and not the object itself.  Therefore, the object’s attributes will not be
changed.  To edit the object itself, quit the Keyframe Editor mode.

Figure 18: Keyframe Editor Window

Note: CoordinateInterpolator and NormalInterpolator are not supported in Key-
frame Editor.

■■■■ Starting or Quitting the Keyframe Editor 
To start Keyframe Editor, click the corresponding icon  in the Main Window

click Keyframe on the Edit menu.

To quit Keyframe Editor, click again the icon  in the Main Window or click Ke

frame on the Edit menu to de-select Keyframe Editor, or click the x (Close) bu
on the top-right corner of the window.
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■■■■ Selecting the Source 
Select, out of the Source combo box, the field (or the event) that controls the Int
lator. Normally you are supposed to select the fraction event of TimeSensor. T
fields or events appear in this combo box, you need to give DEF names to Tim
sor and so on.

■■■■ Enlarging/reducing or scrolling the display 

Click the enlarge/reduce  icons to enlarge or reduce the display area. 

Click the scroll icon  to scroll the display area.

■■■■ Specifying the fraction 

••••     From field and To field
Specifies the Keyframe Editor display area. This area varies if the enlarge/re
or scroll button is clicked.

••••     Current field
Specifies the location when Keyframe is to be added. This value varies if the 
tion panel (the calibrated portion) is clicked.

■■■■ Locking the display 
When you check the Lock checkbox, the enlarge/reduce buttons, the scroll b
the From and To fields become inoperable.

■■■■ Seeing how animation works on the screen 
Click the Play button  to see how the linkage between the Interpolator an

current Source works on the display.

Note: To see how the entire world works on the screen, quit the Keyframe Editor
and then press the Play button in the Main Window.
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■■■■ Loop checkbox 
Specifies whether to loop the animation or not.  If TimeSensor is specified in
Source combo box, it will work together with the loop field. 

■■■■ Selecting multiple Keyframes
More than one keyframe that belong to the same Interpolator can be select
clicking while holding down the Shift key.

■■■■ Pop-up menu 
Right clicking in the Keyframe edit area will display the popup menu shown on 
ure 16.

••••     New Keyframe 
Adds a new Keyframe on the location specified with the current Fraction.

••••     Cut 
Cuts the selected Keyframe. The Keyframe that has been Cut is loaded on
clipboard. Cut is valid only for the Interpolator currently selected.

••••     Copy 
Copies the selected Keyframe. The Keyframe that has been Copied is loade
the clipboard. Copy is valid only for the Interpolator currently selected.

••••     Paste 
Pastes the Keyframe that was Cut or Copied. 

••••     Select all 
Selects all the Keyframes contained in the Interpolator selected. 

••••     Manipulate selection 
You can apply the Keyframe operations (explained below) to more than one 
frames selected.

••••     Copy column to 
Copies the Keyframe contained within the current Fraction to the other Frac
This function is useful when copying more than one Interpolators.
34



Keyframe Editor Window

ver, is

 then
Figure 19: Pop-up menu 

■■■■ Keyframe operations (Scaling and Smoothing) 
You can scale or smooth more than one Keyframe selected. Smoothing, howe
effective only for PositionInterpolator. 
While keeping the Shift key caved-in, you can select more than one Keyframe,
right-click to bring up the pop-up menu, and select Manipulate selection.

Note: Smoothing can only be done on PositionIterpolator.

••••     Scaling
Scale Sheet is displayed when you select the Scale tab shown on Figure 17.

Scaling Factor: 
Specifies the value for scaling. 

50%: double speed
200%: half speed
-100%: invert

Scaling point: 
Specifies the center position for scaling. 

Left-hand keyframe: left-most
Center of selection: center position
Right-hand keyframe: right-most position of the keyframe
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Figure 20: Keyframe operations dialog (the Scale tab) 

••••     Smooth
Creates intermediate keyframes with the Bezier curve. This enables smo
interpolation.

# of smoothing keyframes: 
Specifies the number of keyframes to newly be inserted to an existing 
frame.

Tension, Bias: 
Specifies the parameters for the Bezier curve. Normally you are suppos
specify within the range of -1.0 to +1.0. Specifying 1.0 for Tension provi
linear interpolation.

Loop first and last keyframe: 
Use this function when the first and last keyframes agree.
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Figure 21: Keyframe operation dialog (the Smooth tab)
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■■■■ The types of library 
This window provides you with various types of libraries, which can be adde
your world by dragging and dropping. By clicking one of the tabs, you can sw
between these libraries.

Figure 22: Library Window

Note: The Movie tab is not supported in the current version. 

■■■■ Dragging and Dropping 

••••     Texture
Select the texture and drag and then drop onto the object on the 2D/3D View
dow to paste it as shown on Figure 23 . 
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Figure 23: Pasting texture by dragging and dropping

••••     Sound, Scri pt, Proto, Wizard: 
Drag and drop onto the 2D/3D View Window. 

Note: You are not allowed, however, to drag and drop the PROTO/Wizard library
onto the PROTO/Wizard definition part.

••••     Avatar:
Drag and drop onto the Multi User Window or the 2D/3D View Window.

Note: Avatar page will appear by pushing the Create Multi User world button in the
Multi User Window.  Refer to "Multi User Window" on page  for more informa-
tion.

■■■■ Starting the related application 
Double-click the icon of the application to preview with related application.

■■■■ Displaying Help in the Script library 
You can display the help information in the Script library by clicking the correspo
ing icon and then pressing the F1 key. The help information will be displayed w
the HTML browser.

Note: This function works only with Netscape Navigator 3.0 or later or Internet
Explorer 3.0 or later.
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Note: If Help menu is selected while Netscape Navigator or Microsoft Internet
Explorer isn’t open, it will open the browser without showing the Help file.  To
view Help, select the Help menu once again. 

■■■■ Changing the Library folder 
Right-click a folder to display the menu on which you can change the folder b
referred to by the library currently displayed. 
To change a folder, double-click your desired folder to open it, and then pres
OK button.

Figure 24:  Dialog for selecting a folder

■■■■ Customizing an icon 
Icons are displayed in the Library Window based on the following rules:

1. Texture files are displayed as icons in the Texture library. 
2. In the library windows, a .bmp file in the same directory as a library file

used as an icon.  If an .bmp file does not exist, _default.bmp within the lib
directory will be used instead. Note that those files are prefixed with 
(Underbar).
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3. If a _default.bmp file does not exist either, the Conductor icon will be u
instead.  Users can customize icons by providing a .bmp file that corresp
to each library file.

Note: The size of an icon file must be 32 x 32 dots or larger.

■■■■ Formats supported in each library 

••••     Texture 
bmp, gif, and jpeg

••••     Sound 
wav, mod

Note: To use mod, DirectX3.0 or higher must have been installed. 

••••     Script
VRML file that defines a script and a class file required.

••••     Proto 
VRML file that defines a PROTO.  PROTO definition and PROTO instance m
be written in the VRML file.

Note: PROTO instance cannot be surounded by another node.

••••     Wiazard
VRML file with the PROTO definition and instance.  Pre-installed library obje
conform to Object Customize Wizard . To create objects that conform to Wiz
see Object Customize Wizard Manual .

••••     Avatar
VRML file that defines the Avatar.

■■■■ Addin g objects to a librar y 
You can add or delete library objects by adding/removing files to/from a libr
folder. You can add objects to the Texture library by dragging and dropping an im
file of a supported format to the Library Window.  To add a PROTO to the PRO
library, change the scope of the Scene Graph Window to the PROTO that you
41
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objects are added or deleted, the corresponding icons will automatically be upd
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Message Window

This window shows you messages, such as the warning messages issued during run-time
or those issued by the Java compiler. 

Figure 25:  Message Window

■■■■ Warning message 
Select the Warning tab to display the warning messages.

■■■■ Message from Java compiler 
Select to display the error messages issued during compilation. If a compile error
occurs, click the corresponding error line to jump to the location of the error.
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Multi User Window

The Multi User Window is used during the creation of a multi-user world.  It can con
ure the multi user server (Community Place Bureau (Bureau from now on)) and the a
that is available in that world.  For usage of the Bureau, refer the manual of the Bure

■■■■ Creatin g  a Multi User World
A button that says "Create Multi User world" will be shown in the Multi User W
dow (This will not be shown when you add a Sony_WorldInfo node in the Sc
Graph window or when you read a multi user world).  To make the currently ed
contents into a multi user world, push this button.  As a result, Sony_WorldInfo n
is generated and it becomes a multi user world.
After doing so, the following configuration of the multi server world and the ava
to be used can be done. 
To change a world back to non-multi user world, delete the Sony_WorldInfo nod
the Scene Graph window.

■■■■ Confi gurin g Multi User Server
When the Server tab is clicked, the Server page shown on     will be displayed.
You can set the host name and the port number of the Multi User Server (the Bu
that the contents will connect to.
The changes made in this page will be reflected to the cpBureau field
Sony_WorldInfo node.  If the "host" section is left blank, it will automatically be 
to "localhost."  This can be used to run the Bureau and the contents in your 
machine for testing the multi user world that you have created.
When the port number section is left blank, it will automatically be set to "512
which is the default port number of the Bureau.
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Figure 1: Selecting the Server tab

■■■■ Specif ying the Avatar
Click on the Avatar tab to display the Avatar page shown on     .  The Avatar 
gives a list of avatars that users can use in the current multi user world.

Figure 2: Selecting the Avatar tab
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••••     Addin g to the Avatar List
Drag  and drop the Avatar icon from the Avatar page of the Library Window
the Avatar page of the Multi User Window (of the 3D View Window) to add
new avatar.  The Avatar pagae in the Library Window can be selected only w
the contents is a multi user world.

Figure 3: Adding Avatar by dragging and dropping

••••     Deletin g from the Avatar List
Choose an Avatar in the Avatar page of the Multi User Window and press D
to delete an Avatar from the list.  Choosing the avatar and selecting "Delete" 
the pop-up menu will also delete an Avatar from the list.
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Figure 4: Deleting the Avatar

••••     Editin g an Avatar
You can verify or edit an available avatar shown in the list.  Select the avata
you wish to edit and select "Preview" from the pop-up menu.  (or push the E
key or double click)
The chosen icon will be surrounded by a red rectangle and the avatar will be
played in the 3D View Window.  
The avatar file will be generated in the Scene Graph Window as an Inline n
and by entering the scope of that Inline node, you can edit the avatar.
Note that the avatar is just temporarily added to the world for editing, and it is
an object included in the world.  The Iniline node of the avatar will be dele
from the world when the world is saved to a file.
To quit editing the avatar, select that avatar in the Avatar page and select 
view" from the pop-up menu.  (or push Enter key or double click)
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Figure 5: Before generating Avatar (top) 
and generating Avatar (bottom)

••••     Checkin g the o peration of the Multi User World
To do an operation check of a multi user world, run the Bureau according to
host and the port number configured in the Server page.
Then, save the current contents and push the Start button to check its opera
the Conductor.
To confirm the figure and movement of the avatar, run more than one Browse
Conductor) and read its contents.  
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Parallel View Window

This window enables you to display up to 3 angles of Parallel View (the parallel pro
tion view): Top View, Side View, and Front View. All these views will always displ
objects in the wire frame mode. 

Figure 6: Parallel View window

■■■■ Displaying and changing your eye position/direction 
The values of your eye position/direction currently set are indicated on the sub-
at the lower-left corner. You can change the following values by clicking the s
panel: 
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The eye position/direction can be moved only on the surface parallel to each
jected plane in world coordinates as shown: 

■■■■ Pop-up menu
Click the right mouse button to display the pop-up menu. It provides the follow
sub-menus: 

••••     Home Position command 
Restores both the eye position and the Zoom ratio to their default values. You
not be shown the process of returning to the home position, but will immedia
be brought back to it.  This is different from the 3D View. The Home Position 
ues are fixed as follows: 

table 1: Values shown on the sub-panel

Description Variable Example

Eye position in world coordinates (P)

Current zoom ratio (S)

Eye direction in world coordinates (V)

table 2: Eye position/direction of Parallel View

View mode Eye position Eye direction

Top View
On the surface parallel to the X-Z
plane

Fixed in the direction of -Y

Side View
On the surface parallel to the Y-Z
plane

Fixed in the direction of -X

Front View
On the surface parallel to t he Y-X
plane

Fixed in the direction of -Z
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■■■■ Creating an object 
You can create objects in the Parallel View Window as well as in the 3D View W
dow. The only difference between them is the position where an object is to be
ated. In Parallel View, an object will be created vertically just below the position 
click the mouse. The world coordinate for the object will be created on the gri
the world coordinate at its 0 position for a corresponding direction of eyes. 

For example, if you have created an object with Top View, it will be created on
grid position (X, 0, Z). 

■■■■ Walk through a virtual world 
You can move in every direction basically in the same manner as you do wit
View. 

First select the Walk mouse mode in the Conductor window. Then, drag the m
with its left button within the Parallel View Window. You are not allowed, howev
to use the arrow keys on the keyboard. 

Each Parallel View allows you only to move on the surface perpendicular to eac
direction. 

Moving in your eye direction will not change the scale of the scene viewed. Th
because the scenes are obtained by the parallel projection. 
Instead, Parallel View provides you with additional functions of Zoom In/Out. 

You can walk through a world in the Parallel View mode as follows: 

table 3: Values of Home Position

View Mode Eye position Eye direction Zoom ratio 

Top View X:0, Z:0 (0, 0, -1) 1.0

Side View Y:0, Z:0 (-1, 0, 0) 1.0

Front View X:0, Y:0 (0, -1, 0) 1.0
51



Parallel View Window

ove

e an
-Z

 rota-
f the
By pressing down Ctrl key and clicking on the Parallel View window, you can m
the viewpoint to that position.

Note: The default value for zoom ratio is set to 1.  Zoom ratio can range from mini-
mum  0.01 to maximum 16, based on the default value of 1.

■■■■ Moving an object 
You can move an object in the same way as you do in 3D View. If you mov
object with Top View, for example, an object is only allowed to move on the X
surface. Its position will never move in the direction of Y-axis.

■■■■ Rotating an object 
You can rotate an object in the same way as you do in 3D View, except that the
tion is made only on the axis that goes through the local coordinate origin o
selected object and is parallel to the eye direction in the current View. 

table 4: Walk through a world

Movement
Modifier 

keys
Mouse Top Side Front

Zoom 
Ratio

Move upward
Drag down-

ward
+Z -Y -Y

Move down-
ward

Drag upward -Z +Y +Y

Move right-
ward

Drag leftward -X -Z -X

Move leftward
Drag right-

wards
+X +Z +X

Zoom in Shift key Drag upward Increase

Zoom out Shift key
Drag down-

ward
Decrease
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■■■■ Scaling an object 
You can scale an object in the same way as you do in 3D View. Dragging the m
toward the center of an object will reduce it. Dragging the mouse away from
object will enlarge it. The center of scaling, however, is the local origin of the ob
while in the 3D View the center of scaling is located at the center of the box en
ing the object. 
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Route window is used to display, add, or delete the routing of events to occur withi
current scope. For the details of the current scope, see the explanation about the
Graph Window. 

You can choose your desired display mode by clicking one of 3 buttons on the left b
of the window:

 : Text display mode 

 : Visual display mode  

 : Mixed display mode  

■■■■ Text display mode:

Figure 7: Route Window
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Route from
NodeName: Name of the node to output an event
eventOut: Name of eventOut(the field name of the eventOut type)

Route to
NodeName: Name of the node to receive an event
eventIn: Name of eventIn(the field name of the eventIn type)

Note:  Every node should have a predefined node name on it.

■■■■ Adding a route 
You can add a route in the following procedure:

1. Select the NodeName of the node to output an event from the list. 

2. Select eventOut from the list. 

3. Select the NodeName to receive an event from the list. 
4. Select eventIn from the list. 

Note: Only the eventIn names with the same name type as the eventOut will appear
on the list. 

5. Pressing the Add button, a route is added and displayed on the routing li

■■■■ Deleting a route 
Select the routing you want to delete, and then press the Delete button.

■■■■ Visual display mode:
In the Visual display mode, you can display routing with icons. Icons are displa
in the units of node, and will be laid out automatically if routes are added or del
The node with a DEF name but without a route will be displayed at the bottom o
window.
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Figure 8:  Visual display mode 

••••     Selecting a route 
Clicking the line connecting nodes, the route appears on the status bar at the
portion of the Route Window. If more than one route exist, they will be displa
in the pop-up format.

                                                                      

Figure 9: When more than one route exist

••••     Adding a route 
Drag and drop icons within the Route Window. You can also add a route by d
ging and dropping between the Route and Scene Graph Windows. (Nodes w
Scene Graph are not required to be have DEF names.)

For the details on how to add a route, see "Tutorial."
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••••     Deleting a route 
First select a route, and then right-click to display the pop-up menu. Selec
route you want to delete on the menu to delete it.

Figure 10: The pop-up menu used to delete a route 

■■■■ Automatically creating and modifying a DEF name 
Drag and drop a node without a DEF name from the Scene Graph Window t
Route Window. The node will automatically be given a DEF name; the DEF n
given here can be modified. The DEF names are created according to the ty
node (such as TouchSensor).
                                                         

Figure 11: Immediately after a DEF name is 
automatically created
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■■■■ Pop-up menu 
When an icon is selected:
You can see the routing given to that icon. 

When an icon is not selected: 

••••      2D Layout 
Lay outs the routing in 2 dimensions.

••••      1D Topological layout 
Lay outs the routing in a single dimension (in geometrical order).

••••      1D Alphabetical layout 
Lay outs the routing in a single dimension (in Alphabetical order).

••••      Animate changes 
Displays the rearrangement of the layout with animation.

••••      Fade descendants 
Displays the nodes contained in the node selected within the Scene Graph
dow with fade-out. This lets you know what routes will be deleted if you de
the node you select.

                                                        

Figure 12: Pop-up menu with no icon selected
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Scene Graph Window

This window displays the tree structure of a world within the current scope.  All
VRML 2.0 nodes will be shown in the tree structure. You can select any of the n
shown and move it with drag & drop.

The nodes which are given DEF names will be displayed with the [ ] mark. The In
node shows the URL within < >.

Figure 13: Scene Graph Window 

■■■■ Switching the current scope 
A VRML file containing the Inline node will be given a single scope. You can w
only on the current scope of each node. You can switch the current scope to a
by using the combo box at the top of the screen.
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Figure 14: The Combo Box for Switching the Current Scope

■■■■ Switching the PROTO scope 
If the file currently selected contains PROTO, the tab for switching the PRO
scope will appear on the screen.

Figure 15: Tab for switching PROTO scope
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Click the node you want to select. The attributes of the selected node can be 
fied from within the Attribute Window. 

Double-clicking the node will both select the node and display the Attribute Wind
as the active window.

■■■■ Displaying the Help information 
By pressing the F1 key, the VRML 2.0 help information will appear on the WW
browser window. If an object is selected, its node will also be explained within
window. 

Note: This function works only with Netscape Navigator 3.0 or later or Internet 
Explorer 3.0 or later. To use this function, start the browser and press the F1 
key.

■■■■ Pop-up menu 

Figure 16: The Pop-up Menu of the Scene Graph Window
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••••     Expand All
Expands all the trees under the currently selected node.

••••     Find Node
The following dialog box will appear.
To search from the DEF name of the Node, click on the "By Name" tab. 
search from the type of the Node, click on the "By Type" tab.
Strings to search can be selected from the combo box.

Figure 17:  Find Node Dialog Box

Direction
Backward: Searches backward
Forward:   Searches forward

Origin
From cursor: Search starts at the cursor point
Entire scope: Searches from the beginning of the file

••••     Search A gain
Search again using the same condition selected during "Find Node."
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••••     Add Node 
Adds the nodes which are prescribed by VRML2.0. The nodes are classified
sub-menus.

Figure 18:  Selecting the Add Node

Add Use
DEF names that are valid in the current scope will be shown.  W
selected, node is created using "USE."

Add ProtoInstance
PROTO’s that are valid in the current scope will be shown in the sub-m
When selected, it adds a new instance.  

••••     Insert Grou ping Node 
Adds the grouping node as a parent node to the currently selected node.

••••     Edit Node 
Adds the grouping node as a parent node to the currently selected node.
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••••     Goto definition 
Jumps to the definition part of the PROTO instance or the Inline node selecte

••••     Point of Interest 
Moves from the current eye position to the front of the selected object.  This
be used only for grouping node, geometry node, light node, and Viewpoint.

••••     Set Node Name 
Displays the dialog used to specify the DEF name for the selected node.

Figure 19:  DEF name Input Dialog 

••••     Create PROTO 
Creates PROTO based on the selected node. The selected node will be re
by the PROTO instance. 

Note:1) By selecting this menu, you will be unable to Undo your work.

Note:2) Creating a PROTO using CreatePROTO will automatically generate DEF
name in capital letters.

••••     Open .wrl 
Displays the VRML file you have loaded. 

••••     Open .java 
Loads a Java file to the Text Editor. You can use this menu only when a S
node has been selected. 

••••     Register to the Librar y
Registers the file referenced by the selected node to the library. 
List of files that can be registered are shown in the sub-menu.  When selecte
registered in the library corresponding to the format of the  file.
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When a scope of a PROTO is selected, PROTO name will be shown in the
menu.  When selected, PROTO that is being edited will be registered to the 
library.

When a file with the same name is already registered, dialog box will appe
confirm overwriting.  If you do not want to overwrite, change the registrat
folder in the next dialog box.  Refer to the section on Library Window for file f
mats.

••••     Open .wrl
Shows the VRML file of the file scope selected in the Text Editor.

Note: You must save the file before displaying the contents of a VRML being edited.

••••     Open .java
Shows the Java file in the Text Editor.  This menu can only be used when S
node is selected and the source file exists.
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Used to create the template (the model) of a Java program conforming to the VRM
script node.

Figure 20:  Script Expert dialog 

■■■■ Using Script Expert 
Fill the following four fields, and then press the OK button:

DEF: 
Names the script node so that the Java program can be called up from VRML.

Class Name: 
Specifies the class name for Java. 
This class name will be used as a file name. 

Note: For a class name, do not include any key word reserved by Java.

Data Type: 
Specifies the VRML data type for eventIn or eventOut.  Choose a data type out 
VRML Data Types listed. 
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field name: 
Specifies the VRML data type for eventIn or eventOut.  Choose a data type out 
VRML Data Types listed. 

Press the OK button in the end. This creates the template (the model) of a Jav
gram and compiles it. The Script node is added to the Scene Graph Window 
same time.

Note: The Script Expert Windows does not allow you to specify more than one
eventIn or eventOut. You can add an event only in the Script Attribute Win-
dow. To do this, first choose the Script node in the Scene Graph Window, and
then select add field in pop-up menu in the Attribute Window. 
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The text editor is used to edit VRML files or Java files. When editing scripts, this text
tor automatically adds or deletes a necessary handler by working together wit
Attribute Window.

Figure 21:  Text Editor window

■■■■ Starting the Text Editor 
The Text Editor will be started by taking one of the following actions:

Select Open .wrl or Open .java in the pop-up menu has been selected in the 
Graph Window.

Drag-and-drop a text file has been dragged and dropped out of the Explorer.

■■■■ Quitting Text Editor
You can close Text Editor by clicking the x button on the upper right corner of
window.  If the file has been modified, a save dialogue will appear.  
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Note: When VRML file is modified after selecting "Open .wrl" from pop-up menu of
the Scene Graph window, changes will not be reflected untill the file is re-
loaded.

■■■■ Pop-up menu 

••••     Compile 
Compiles the file being edited. If the compile completes successfully, "Finish
appears in the Message Window. If an error occurs, a corresponding error 
sage will appear.

••••     Find 
A dialog box will appear to search for the text included in the file being edited

Figure 22:  Find Text dialog box

Text to Find:  Enter the text to search for
Replace to: Enter text to replace the above text

Option
Case Sensitive: When checked, the search will be case sensitive.
Entire Word: When checked, searches for words that include the text.

Direction
Backward: Backward search
Forward: Forward search

Origin
From cursor:  Starts searching from the cursor point.
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Entire scope:  Searches the entire file.

••••     Find Next
Searches again using the same condition given in the Find dialog.

••••     Go to Line Number
Jumps to the specified line.

••••     Cut/Copy/Paste/Delete 
You can Cut/Copy/Paste/Delete texts.

••••     Close File 
Closes a file.

••••     Save File 
Saves a file.

••••     Read Only 
Changes the Read Only attribute of a file.
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On Texture Mapping window, you can specify the color and texture mapping to
IndexedFaceSet node.

Note: This window can only be used when IndexedFaceSet is selected

Each of the sheets are described below. 

■■■■ Color sheet
By clicking the Color tag, the Color page shown below will be displayed.  This p
will only be displayed when non-default Color Mode is selected.
The components of the Color sheet are as follows:

Figure 23: Color sheet
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(1) Face
When the Color sheet is active, the face screen displays the current face as it 
appear if the IndexedFaceSet had no texture. 

(2) Color toolbar
The tools are used by clicking or dragging onto the Face area.  

(4) Fill all faces
This button fills all faces with the current color. 

(5) Current color
The current color is displayed here. Clicking on the color swatch pops up a 
choosing dialog. This feature could be replaced by a built-in color chooser on
Color sheet. 

(6) Recently used colors
Old colors are moved into this area, so that the user may switch back by clickin
one of the swatches. 

(7) Status bar
This contains a different message depending on the color mode and tool.  F
brush tool, the following messages shown in Table 16 are used. 

table 5: Color toolbar

Button Function

 Brush tool Applies the current color to faces or vertices

 Dropper tool Sets the current color to be the same as the neare
vertex to the mouse position.
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■■■■ Texture Coordinate sheet
By clicking the Texture Coordinate tag, the Texture Coordinate sheet shown b
will be displayed.  This will only be displayed when a non-default Texture Mod
selected.

The components of the color sheet are as follows: 

Figure 24: Texture coordinate sheet

(1) Texture sample
Shows the current texture and texture coordinates. When the Texture Coord
sheet is active, the current face is shown in black with its texture applied.  If the

table 6: Color mode messages

 Color mode: Message:

1 color per face (indexed) Click on the face to use this color.

1 color per face Click on the face to use this color.

1 color per vertex
Click near a vertex to change its color. 
This will also affect adjacent faces.

1 color per vertex (indexed) Click near a vertex to change its color.
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no texture, or the texture url cannot be loaded, a default texture is used so tha
dinates may be set properly.  

(2) Texture coordinate tools
Contains the tools described below.  All of these tools are operated by draggin
mouse within the texture sample. 

(3) Texture sample tools
These have no effect on the texture coordinates.  These are used to adjust 
coordinate display on the Texture sample. 

  

table 7: Texture coordinate tools

Button Function

 Point-by-point texture coordinate points may be individually positioned

 Transform all texture coordinates may be moved as a group

 Rotation all texture coordinates may be rotated around a chose
point

 Scale
all texture coordinates may be scaled in the x and y direc
tions by manipulating the corners of the bounding rectan
gle of the texture coordinates 

 Skew all texture coordinates may be skewed in the x or y direc
tion

table 8: Texture sample tools

Button Function

 Zoom

The left mouse button zooms in and the right mouse button zoom
out, centering the new view at the position that the mouse 
clicked.

 Pan The user may pan the texture sample by dragging the mouse.
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(4) Default mapping
Sets the texture coordinates such that the bounding box of the texture coordina
inside the rectangle [0, 0, 1, 1]. 

(5) Zoom to fit
Adjusts the zoom and pan settings such that the texture coordinates all appear 
the texture sample. 

(6) Projection
Pops up the Projection dialog. 

(7) Status bar
The status bar is used to present helpful messages regarding the current tool. 

(8) Mesh Type
 Specify the display region of the Mesh, as shown on table9.

(9) Mesh Color
 When the Mesh type is either "Show neighbor faces" or "Show all faces", sp
the color of the Mesh which is not selected.

(10) Status bar
The status bar is used to present helpful messages regarding the current tool. 

■■■■ Color Mode dialog
The Color Mode dialog (Figure 40) allows the user to set the current Indexed
eSet’s "color", "colorIndex", and "colorPerVertex" fields.  The default mode is "U
Appearance".  The user may choose a color mode from the list of radio buttons

table 9: Mesh Type

Mode Description

Show selected face Shows only the selected faces

Show neighbor faces Shows neighbor faces

Show all faces Shows all faces
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Figure 25:   Change color mode dialog

A summary of the VRML structure for each color mode is given in the table belo

table 10: Color modes

 Mode colorPerVertex color field colorIndex field

Use Appearance -- not used not used

1 color per face
(indexed)

FALSE used used

1 color per face FALSE used not used

1 color per vertex FALSE used not used

1 color per vertex
(indexed)

FALSE used used
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In the Notes section of the dialog box, a brief description of the currently sele
color mode is given.  Following is a list of the description texts: 

Note: When "1 color per vertex" or "1 color per vertex (indexed)" is selected in
Change Color Mode, appropriate color might not appear in the 3D View Win-
dow.

In some cases, changing the color mode will change how the object appear
instance, when switching to "Use Appearance", all color information is lost).  A
of the transitions that may cause the current coloring scheme to change is giv
the table below. 
  

table 11: Description of the color modes

Color mode Description

Use Appearance
This IndexedFaceSet uses the color information given in it
Appearance node.

1 color per face
(indexed)

Each face has a solid color, which is chosen from a palette 
colors.  This will optimize the file size if the number of dif-
ferent face colors is small (but greater than one). 

1 color per face
Each face has a solid color.  This will optimize the file size if
the number of different face colors is large.

1 color per vertex
Each vertex has its own color.  Vertices shared by sever
faces must have the same color.

1 color per vertex
(indexed)

Each vertex has its own color. Vertices shared by sever
faces may have different colors. 

table 12: Color mode transitions that can change the object’s coloring

From: To:

1 color per face (indexed) Use Appearance, 1 color per vertex

1 color per face Use Appearance, 1 color per vertex

1 color per vertex
Use Appearance, 1 color per face (indexed), 1
color per face

1 color per vertex (indexed) any
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Note: No changes are made to the scene unless OK is clicked. 

■■■■ Change Texture Mode dialog
Change Texture Mode dialog (Figure 41) allows the user to set the current Ind
FaceSet’s "texCoord" and "texCoordIndex" fields.  The default mode is "Def
mapping". The user may choose a texture mode from the list of radio buttons.  

Figure 26:  Change texture mode dialog

A summary of the VRML structure for each texture mode is given in the table be

table 13: Texture modes

Mode coord field coordIndex field

Default mapping not used not used
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In the "Notes" section of the dialog box, a brief description of the currently sele
color mode is given.  Following is a list of the description texts: 

As with color mode transitions, some texture mode transitions may change
object’s appearance.  A list of the transitions that may cause the appearance 
object to change is given in Table 24. 
  

Note: No changes are made to the scene unless the OK button is clicked. 

1 coordinate per vertex used not used

1 coordinate per vertex per face used used

table 14:  Description of the texture mode

Texture Mode Description

Default mapping
This IndexedFaceSet will be textured automatically using th
method given in the VRML specification.

1 coordinate per
vertex

This IndexedFaceSet may be textured in a custom fashio
Each vertex has one texture coordinate, even the vertex 
shared by several faces.

1 coordinate per
vertex

This IndexedFaceSet may be textured in a custom fashio
Each vertex has one texture coordinate for each face that us
it.

table 15: Texture mode transitions that can change the object’s texturing

From: To:

1 coordinate per vertex Default mapping

1 coordinate per vertex per face any

table 13: Texture modes

Mode coord field coordIndex field
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■■■■ Texture Mapping Projection dialog
The projection dialog (Figure 42) allows the user to set all texture coordinates s
taneously using a "projection".  The principle behind this technique is that the
ture is applied to an imaginary shape (sphere, cylinder, or plane) using the sta
VRML texture mapping system for that shape.  Then the points of the Indexed
eSet are mapped to points on the imaginary shape, and the corresponding t
coordinate is used. 

  

Figure 27: Texture Mapping Projection dialog

The user may choose one of the following projection styles: 

table 16: Projection Style Description

Projection 
Style

Description

Spherical

Let s be an imaginary sphere that surrounds the IndexedFaceS
For each vertex v, let l be a line passing through v and the center
s. The texture coordinate at v is equal to the texture coordinate
the intersection of s and l. 
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The user may control the orientation of the imaginary shape that is used for the
jection by specifying a VRML-style (x, y, z, r) rotation to be applied to the proj
tion shape.  If the OK button is clicked, the projection is applied to the current sh

The "correct seam" option is useful for spherical or cylindrical projections.  In th
cases, it is possible for a face to cross the seam, so that the shape’s left side h
coordinate that is larger than the right side’s s coordinate.  This problem is solv
adding 1.0 to the right side of the shape.  However, if "1 coordinate per vertex" m
is being used, this may not work because a single vertex would need to have tw
ferent values.

Note:  In "1 coordinate per vertex" mode it will not function correctly since 1 vertex
must contain 2 different values.

Cylindrical

Let c be an imaginary cylinder that surrounds the IndexedFaceS
For each vertex v, let l be a line that passes through v and the c
tral axis of c, and is perpendicular to the central axis.  The textu
coordinate at  v is equal to the texture coordinate at the intersecti
of c and l.

Planar
Let p be an imaginary plane.  For each vertex v, the texture coord
nate at v is equal to the texture coordinate on p at the point clos
to v. 

table 16: Projection Style Description

Projection 
Style

Description
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Object Customize Wizard Operating Instructions

Conductor 2.0 offers the Object Customize Wizard functions which enable you to
object attributes more easily than you do with the usual Attribute Window. If the ob
you select is supported in Wizard, the Wizard tab appears in the Attribute Window
Wizard tab helps you with its user-friendly GUI (Graphical User Interface) to edit ob
attributes to meet your needs. 

Figure 28: Attribute window

■■■■ Modif ying VRML ob jects
To get VRML objects to be supported in Wizard, modify the VRML objects and p
vide the Wizard description file, as shown in the following procedure.  The orde
operation will be shown in parentheses. 
82



Object Customize Wizard Operating Instructions

 

ted

raph

Info
ce

ve all

xam-

iz-
pear
ard
 line
ant
cond
1. Create a Script node. (Scene Graph Window/Add Node/Common/Script)

2. Add the wizInfo field of the MFString type. (Attribute Window/add field)

3. Type, in that field, the url of the Wizard configuration file that is to be crea
later.  (Attribute Window) 

4. Define the Transform node created in step 1) as a PROTO. (Scene G
Window/Create PROTO) 

5. Go to the PROTO definition area (the PROTO scope).  Expose the wiz
field and the fields which will be modified by using Wizard to the interfa
section. (Attribute Window/map with IS) 

6. Return to the body tab which includes PROTO instances. Delete and sa
the nodes. 

■■■■ Entering necessary information in the Wizard configuration
file

You can enter necessary information in the file by using the text editor.  (See e
ples of setting files.) 

The UI’s are displayed sequentially from the top of the Wizard Window. In the W
ard configuration file, you are supposed to type UI settings in the order they ap
in the Wizard Window. If you want the slider bar to appear on top of the Wiz
Window, type "slider," and the attributes such as its maximum value on the first
of the Wizard configuration file (see Setting the slider bar for details). If you w
the radio button to be displayed next, type "radio" and its attributes on the se
line (see Setting the radio button for details). 
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If Wizard includes more than one UIs of the same kind (two slider bars, for ex
ple), type [slider.1] or [slider_height] for example, to distinguish them by addin
string after "slider." If the strings within [ ] begin with "slider," the informatio
within [ ] is identified as the name of a slider. 

The UI’s and identifiers currently available are as follows: 

••••     Setting the slider

Example ----------------------------- 

[slider.1] 
name=height 
caption="Height of Seat" 
value=32 
min=10 
max=80 

------------------------------- 

table 17: UI’s and identifiers

UI Identifier

Slider Bar  [slider]

Radio button [radio]

Combo box [combo] 

Color picker [color] 
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••••     Setting the radio button

Example ----------------------------- 

[radio_2] 
name=type 
caption="Type of Seat" 
value=0 
option=rectangle,circle 

------------------------------- 

table 18: 

name
The name of UI within this configuration file.
You cannot specify the same name for other UIs within the file.
No blank spaces are allowed.

caption
The name of this UI to be displayed in the Wizard window.
Specify a name that is easy to understand.
If it includes a blank space, specify it in double quotations.

value
Default value for the slider bar.
Only integers are currently allowed.

min
The minimum value for the slider bar.
Only integers are currently allowed.

max
The maximum value for the slider bar.
Only integers are currently allowed.
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••••     Setting the Combo box

Example ----------------------------- 

[combo1] 
name=shape 
caption="Shape of Seat" 
value=0 
option="rectangle","circle" 

------------------------------- 

You can set the combo box in the same procedure as you do with the radio bu

For details, see Setting the radio button. 

table 19: 

name
The name of UI within this configuration file.
You cannot specify the same name for other UI’s within the file.
No blank spaces are allowed.

caption
The name of this UI to be displayed in the Wizard window.
Specify the name that is easy to understand.
If it includes a blank space, specify it in double quotations.

value
Default value for the radio button.
Type "0" to specify the first option, or "1" to specify the second option

option

Description about each option that can be selected for the ratio butto
Insert a comma between strings.
Specify a name that is easy to understand.
If it includes a blank space, specify it in double quotations.
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••••     Setting the color picker

Example ----------------------------- 

[color] 
name=color 
caption="Color of Seat" 
value=0.5 0.8 0.5  

------------------------------- 

••••     Linking each Wizard UI with a VRML field
To have the value specified for the Wizard UI reflected in VRML, you have
specify the link between each UI and a VRML field. 

Type [route] on the first line, and type the link information on the following lin
Specify the link between each UI and a field in the equation. Type the name o
UI field on the left, and that (specified in "name") of UI on the right. Be sure
specify the link information at the end of the file after all the other UI settin
shown above. 

table 20: Description of variables in Combo box

name
The name of UI within this configuration file.
You cannot specify the same name for other UI’s within the file.
No blank spaces are allowed.

caption
The name of this UI to be displayed in the Wizard window.
Specify a name that is easy to understand.
If it includes a blank space, specify it in double quotations.

value
Default value for the color picker.
Specified in the same RGB format as VRML.
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Example ----------------------------- 

[route] 
seatTrans.y=(height - 32) / 100 
poleScale.y=height * 2 / 64 
seatType=shape 
seatColor=color  

------------------------------- 
On the left of an equation, you can specify a field of the SFFloat, SFIn
SFColor, SFVec3f, or SFRotation type which is specified in the PROTO interfa
FVec3f and SFRotation must be resolved into components. 
Resolve SFVec3f into x, y, and z. Specifying "seatTrans.y" as shown above
example, you can set the value on the right of an equation to the y compon
the seatTrans field (the SFVec3f type). Resolve SFRotation into x, y, z, and a
and specify "seatRot.angle" on the right of an equation, for example. You
omit ".angle," however, and specify "seatRot" because "angle" is its default va

Specify on the right the name of the UI used to set value in the VRML field on
left. If the field on the left is anything other than the SFColor type (namely
SFFloat, SFInt32, SFVec3f, or SFRotation type), you can specify a nume
expression on the right. The numerical expression is allowed to include the 
of UI, constants, an operator of the four fundamental rules of arithmetic, 
parentheses. 

You can also link a single UI to several VRML fields. In the above example,
UI value of height is used to set value to both seatTrans.y and poleScale.y. 

••••     Others
When you start Conductor, the VRML files appear under the PROTO tab o
Library Window. By default, the files which appear are only those files loca
immediately under datalib/proto/ contained in the directory where the Condu
is installed. The VRML files below those contained in datalib/proto/ will n
appear in the Library Window. 

A bitmap file having the same name as a VRML file and a .bmp extention wil
used as an icon in the Library Window. 
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■■■■ Introduction
This document provides a detailed definition of the scripts that were prepare
Community Place Conductor. The table below lists the topics in this document. 

table 21: Table of contents--Script Reference

Basic Scripts
Movement 

Scripts
Other Scripts

CPSCNot CPSCBoolVec CPSCMoveOn CPSCShowBool

CPSCAnd CPSCBoolRot CPSCMoveIt CPSCShowFloat

CPSCOr CPSCEdge CPSCMoveAlong CPSCShowInt

CPSCXor CPSCStep CPSCMoveTo CPSCShowVec

CPSCSineWave CPSCUpper CPSCRotateAlong CPSCReturnBool

CPSCToggle CPSCLower CPSCRotateTo

CPSCToggleFrac CPSCMatch CPSCFace

CPSCBoolToTime CPSCRange

CPSCFloatToInt CPSCDelayGen
89



Script Reference

n. 

. 

ther-
CPSCNot

DEF CPSCNot Script {
  url "scripts/CPSCNot.class"
  eventIn  SFBool   inBool
  eventOut SFBool   outBool
  field    SFString info "this is CPSCNot script."
  }

This script returns the logical "not" value of the boolean inBool. 
For example, it returns "false" if "true" is given, and returns "true" if "false" is give

CPSCAnd

DEF CPSCAnd Script {
  url "scripts/CPSCAnd.class"
  eventIn  SFBool inOne
  eventIn  SFBool inTwo
  eventOut SFBool outBool
  field SFString info "this is CPSCAnd script"
  }

This script returns the logical "and" value of the 2 booleans (inOne, inTwo)given

"True" is returned when both of the inputs are "true", and "false" is returned o
wise.
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CPSCOr

DEF CPSCOr Script {
  url "scripts/CPSCOr.class"
  eventIn  SFBool inOne
  eventIn  SFBool inTwo
  eventOut SFBool outBool
  field SFString info "this is CPSCOr script"
 }

This script returns the logical "or" value of the 2 booleans (inOne, inTwo) given.

"False" is returned when both of the inputs are "false", and "true" is returned o
wise. 

CPSCXor

DEF CPSCXor Script {
  url "scripts/CPSCXor.class"
  eventIn  SFBool inOne
  eventIn  SFBool inTwo
  eventOut SFBool outBool
  field SFString info "this is CPSCXor script"
  }

This script returns the logical "exclusive or" of the 2 booleans (inOne, inTwo) giv

If the two booleans given to the script are equal to each other, the script re
"false", and if they are different, the script returns "true". 
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CPSCSineWave

DEF CPSCSineWave Script {
  url "scripts/CPSCSineWave.class"
  eventIn  SFFloat inFloat
  eventIn  SFFloat phase
  eventIn  SFFloat amplitude
  eventIn  SFFloat waveLength
  eventOut SFFloat outFloat
  field SFString   info "this is CPSCSineWave script"
  }

This script returns the sine value of the float, with phase(0.0) for phase, am
tude(1.0) for amplitude, and waveLength(1.0) for length of the wave. The value
parentheses are the default values of the variables. 

CPSCToggle

Def CPSCToggle Script {
  url "scripts/CPSCToggle.class"
  eventIn   SFBool  inBool
  eventOut  SFBool  outBool
  field     SFBool  defBool TRUE
  field SFString    info "this is CPSCToggle script."

  }

This is the toggle switch. Whenever a "true" event is given to the script, the s
returns "true" or "false" alternatively. The first value that will be given to outBoo
defined in the defBool field, and its default value is TRUE. 
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CPSCToggleFrac

Def CPSCToggleFrac Script {
  url "scripts/CPSCToggleFrac.class"
  eventIn   SFFloat  inFloat
  eventOut  SFFloat  outFloat
  field SFString info "this is CPSCToggleFrac script."

  }

This script is useful for toggling interpolators. At the beginning, forward is se
"true". Whenever inFloat decreases, forward is toggled between "true" and "fals
forward is "true", outFloat = inFloat, and otherwise it will be 1 - inFloat. 

CPSCBoolToTime

DEF CPSCBoolToTime Script {
  url "scripts/CPSCBoolToTime.class"
  eventIn  SFBool inBool
  eventOut SFTime outTime
  field SFString  info "this is CPSCBoolToTime script."
  }

When the script receives a "true" event, it returns the time stamp of that event. A
same time, it prints out the time (as a double) in the Java Console. 

CPSCFloatToInt

DEF CPSCFloatToInt Script {
  url "scripts/CPSCFloatToInt.class"
  eventIn  SFFloat inFloat
  eventOut SFInt32 outInt
  field SFString   info "this is CPSCFloatToInt script."
  }

This script rounds the given float to the nearest integer value. 
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CPSCBoolVec

DEF CPSCBoolVec Script {
  url "scripts/CPSCBoolVec.class"
  eventIn  SFBool    inBool
  eventOut SFVec3f   outVec
  field SFVec3f      vector 0 0 0
  field SFString     info "this is CPSCBoolVec script."
  }

When the script receives a "true" event, it returns a vector value specified in the
tor field of the script. The default values are 0, 0, 0. 

CPSCBoolRot

DEF CPSCBoolRot Script {
  url "scripts/CPSCBoolRot.class"
  eventIn  SFBool       inBool
  eventOut SFRotation   outRot
  field SFRotation      rotate 0 0 1 0
  field SFString       info "this is CPSCBoolRot script."
  }

When the script receives a "true" event, it returns a rotation specified in the r
field of the script. The default values are 0, 0, 1, 0. 
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CPSCEdge

DEF CPSCEdge Script {
  url "scripts/CPSCEdge.class"
  eventIn  SFBool   inBool
  eventOut SFBool   outBool
  field    SFString info   "this is CPSCEdge script"
  }

This script returns "true" or "false" alternatively whenever the input changes 
"true" to "false" or vice versa. If the input value does not change (for example, k
on giving "true"), the script does not return any value. 

CPSCStep

DEF CPSCStep Script {
  url "scripts/CPSCStep.class"
  eventIn  SFBool   inBool
  eventOut SFFloat  outFloat
  field    SFFloat  lower 0.0
  field    SFFloat  upper 10.0
  field    SFFloat  step 1.0
  field    SFString info   "this is CPSCStep script"
  }

When "true" is given to this script, it returns a float, starting from the value at f
lower up to the value at field upper. Every time the value "true" is given to the sc
it adds the amount specified in the field step and returns that value. It will stop
ing step whenthe value exceeds the value specified at upper. 

Take the default value for example. The first time it receives "true" the script ret
0.0. The next time it receives "true" it will return 1.0, then 2.0, and so on. Aft
while it will return 10.0, but if you add to this value, it would exceed the value sp
ified at field upper.  Hence, the calculation will stop here and the script will kee
returning 10.0 every time after that. 

The value at fields upper, lower, and step, and the value that is being returne
also be printed out on the Java Console. 
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CPSCUpper

DEF CPSCUpper Script {
  url "scripts/CPSCUpper.class"
  eventIn  SFFloat  inFloat
  eventOut SFBool   outBool
  field    SFFloat  limit 5.0
  field    SFString info   "this is CPSCUpper script"
  }

This script will return "true" if the value received exceeds the value specified in
field limit. If the value is less than or equal to limit, it will not return any values.  

The default value given to the field limit is 5.0, which means that whenever a v
bigger than 5.0 (for example 6.0) is given, the script will return "true". 

CPSCLower

DEF CPSCLower Script {
  url "scripts/CPSCLower.class"
  eventIn  SFFloat  inFloat
  eventOut SFBool   outBool
  field    SFFloat  limit 5.0
  field    SFString info   "this is CPSCLower script"
  }

This script will return "true" if the value received is less than the value specifie
field limit. If the value is more than or equal to limit, the script will not return a
values.  

The default value given to the field limit is 5.0, which means that whenever a v
smaller than 5.0 (for example 4.0) is given, the script will return "true". 
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CPSCMatch

DEF CPSCMatch Script {
  url "scripts/CPSCMatch.class"
  eventIn  SFFloat  inFloat
  eventOut SFBool   outBool
  field    SFFloat  value 5.0
  field    SFString info   "this is CPSCMatch script"
  }

This script will return "true" if the value received matches the value specified at 
value. If the received value does not equal to value, the script will not return any
ues.  

The default value given to the field value is 5.0, which means that whenever a 
5.0 is given, the script will return "true". 

CPSCRange

DEF CPSCRange Script {
  url "scripts/CPSCRange.class"
  eventIn  SFFloat  inFloat
  eventOut SFBool   outBool
  field    SFFloat  upperLimit 6.0
  field    SFFloat  lowerLimit 4.0
  field    SFString info   "this is CPSCRange script"
  }

If the value given to the script is in the range of the values specified by the  f
upperLimit and lowerLimit, the script returns "true". If the value does not e
between lowerLimit and upperLimit, the script will not return any values. 

The default value given to the field lowerLimit and upperLimit is 4.0 and 6.0, wh
means that whenever a value between 4.0 and 6.0 (including 4.0 and 6.0) is 
the script will return "true". 
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CPSCDelayGen

DEF CPSCDelayGen Script {
  url "scripts/CPSCDelayGen.class"
  eventIn  SFTime   inTime
  eventOut SFTime   outTime
  field    SFFloat  delay 5
  field    SFString info   "this is CPSCDelayGen script"
  }
When a SFTime event is received, the script adds the float value given at field 
to the time received and returns that value. The default value set to the field de
5.0. 
  

CPSCShowBool

DEF CPSCShowBool Script {
  url "scripts/CPSCShowBool.class"
  eventIn  SFBool   inBool
  eventOut SFBool   outBool
  field    SFString info   "this is CPSCShowBool script"
  }

This script prints out the boolean value received on the Java Console, and r
that same value. This script is used to test if the correct value is being given t
next script.

CPSCShowFloat

DEF CPSCShowFloat Script {
  url "scripts/CPSCShowFloat.class"
  eventIn  SFFloat   inFloat
  eventOut SFFloat   outFloat
  field   SFString  info   "this is CPSCShowFloat script"
  }

This script prints out the float received on the Java Console, and returns that
value. This script is used to test if the correct value is being given to the next sc
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DEF CPSCShowInt Script {
  url "scripts/CPSCShowInt.class"
  eventIn  SFInt32   inInt
  eventOut SFInt32   outInt
  field    SFString  info   "this is CPSCShowInt script"
  }

This script prints out the integer received on the Java Console, and returns tha
value. This script is used to test if the correct value is being given to the next sc

CPSCShowVec

DEF CPSCShowVec Script {
  url "scripts/CPSCShowVec.class"
  eventIn  SFVec3f   inVec
  eventOut SFVec3f   outVec
  field    SFString  info   "this is CPSCShowVec script"
  }

This script prints out the vector (SFVec3f) received on the Java Console, and re
that same value. This script is used to test if the correct value is being given t
next script. 

CPSCReturnBool

DEF CPSCReturnBool Script {
  url "scripts/CPSCReturnBool.class"
  eventIn  SFBool   inBool
  eventOut SFBool   outBool
  field    SFBool   retBool TRUE
  field   SFString info   "this is CPSCReturnTrue script"
  }

Whenever this script receives a boolean value, it returns the boolean defined 
field retBool. 
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DEF CPSCMoveOn Script {
  url "scripts/CPSCMoveOn.class"
  eventIn  SFFloat      inFloat
  eventOut SFVec3f      posChange
  eventOut SFRotation   oriChange
  field   SFString     info   "this is CPSCMoveOn script"
  }

This script defines the movement and rotation of an object. User can modify the
source to change the movements. The default movement is a sine wave on t
plane. 
  

CPSCMoveIt

DEF CPSCMoveIt Script {
  url "scripts/CPSCMoveIt.class"
  directOutput TRUE
  eventIn  SFBool   clicked
  field    SFNode   node NULL
  field    SFString info   "this is CPSCMoveIt script"
  }

This script moves an object to a certain point (which will be defined in the sc
every time it receives a TRUE value. 
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CPSCMoveAlong

DEF CPSCMoveAlong Script {
  url "scripts/CPSCMoveAlong.class"
  directOutput TRUE
  eventIn  SFVec3f   position
  field    SFNode    node NULL
  field SFString info "this is CPSCMoveAlong script"
  }

This script moves the node to a new position relative to the original position o
node. This script can be used with the Position Interpolator to move a node alon
Interpolator. 
 

CPSCMoveTo

DEF CPSCMoveTo Script {
  url "scripts/CPSCMoveTo.class"
  directOutput TRUE
  eventIn  SFFloat   fraction
  eventIn  SFVec3f   position
  field    SFNode    node NULL
  field    SFString  info   "this is CPSCMoveTo script"
  }

When the script receives a new fraction, it moves the object defined in the field n
towards the specified position (which means that if no new value is given to pos
it will not move).
Pay attention to the "Translation" field of the node. There might be several "Tra
tion" fields in the node referred to by the script, and it might not move to 
expected position if the correct "Translation" hasn’t been selected. (Especially
moving the node by dragging onto the mouse. It creates a new "Translation
doing so, and makes it difficult to determine what the combined transforma
would be.)
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CPSCRotateAlong

DEF CPSCRotateAlong Script {
  url "scripts/CPSCRotateAlong.class"
  directOutput TRUE
  eventIn  SFRotation   orientation
  field    SFNode       node NULL
  field SFString   info  "this is CPSCRotateAlong script"
  }

This script rotates the node to a new orientation relative to the original orientatio
the node. This script can be used with the Orientation Interpolator to rotate a 
along the Interpolator. 
 

CPSCRotateTo

DEF CPSCRotateTo Script {
  url "scripts/CPSCRotateTo.class"
  directOutput TRUE
  eventIn  SFFloat      fraction
  eventIn  SFRotation   orientation
  field    SFNode       node NULL
  field   SFString    info  "this is CPSCRotateTo script"
  }

When the script receives a new fraction, it rotates the object defined in the field n
according to the specified orientation (which means that if no new value is give
orientation, it will not rotate).
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DEF CPSCFace Script {
  url "scripts/CPSCFace.class"
  directOutput TRUE
  eventIn  SFVec3f      inVec
  eventIn  SFRotation   outRot
  field    SFNode       node NULL
  field    SFString     info   "this is CPSCFace script"
  }

When the script receives a new vector in inVec, it rotates the object defined i
field node, so that it will face towards (or in case of a cone, it will point to) the p
defined in the inVec.
You must be careful of the transform node of the object to rotate. You might ha
form another transform node under the object in the heiarchy and fix its orient
in order for the script to rotate the object correctly. 
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